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Editorial 
Hello and welcome to the 

October issue of 2DArtist. 

If you are anything like me 

you are already wondering 

where the nice sunny 

days have gone, and are 

slowly getting depressed by the short days and dark nights. But it’s not 

all doom and gloom, if you are stuck inside what is there better to do 

than sit down with the new issue or 2DArtist and be inspired.

And if it is inspiration you are after this issue is perfect for you. This 

month’s gallery is full of exceptional art by exceptional artists, including 

work from Brad Rigney, Daarken, Andreas Rocha, Ignacio Bazan 

Lazcano and Sergey Musin. I can almost hear your jaws drop to the 

floor! 

As if that wasn’t enough our making of this month is by surrealist genius 

Yang Xueguo, and he tells us how he created his great image Concrete 

5 and gives us a master class in painting light! From the Surreal we 

jump to the stereoscopic, you all thought that 3D was limited to the 

world of 3D Modeling and sculpting, well this month we are proved 

wrong as we catch up with Theo Prins. Theo is an amazing digital 

painter who has mastered the art of stereoscopic painting.

James Wolf Strehle is this month’s sketchbook artist. James has been 

in the 2DArtist gallery on many occasions, and this month we get to 

have a look at how he starts his digital painting process.

Ok, so on to the tutorials. For all of those who have been enjoying the 

Futuristic Marines series we have a slightly different twist on the subject 

this month. Alex Ruiz shows us that Futuristic marines don’t have to be 

male to look tough, and shows us how he broke away from his usual 

process to create his great locker room scene.

On the subject of futuristic marines, the next instalment of the concept 

art for games series shows us how to design the main character of our 

game. Bart Tiongson is our instructor again this month, and gives us 

Fantasy plays a huge part in digital art. It influences thousands of 

artists from around the world and has become a large part of the film 

and gaming industry. So much of what we see within this genre is 

drawn from fairy tales and folklore. In this tutorial series our artists will 

be showing us how to research creatures from folklore and use this 

gathered information to create an original and accurate depiction of 

these fantasy characters.

- Free Brushes

Chapter 1: September Issue | Goblin | Andrei Pervukhin 
Chapter 2: This Issue | Fairy | Nykolai Aleksander 
Chapter 3: November Issue 59 | Siren | Min Yum 
Chapter 4: December Issue 60 | Ogre | Richard Tilbury 
Chapter 5: January Issue 61 | Troll | Simon Dominic Brewer

“I spend a lot of time 
biking around with my 
laptop, sitting in different 
places and painting”

Theo Prins is a fascinating digital artist living in Washington USA. He’s 

spent periods of his life in a variety of different and diverse locations around 

the world, which have clearly influenced his art, and he’s also a pioneer of 

Stereoscopic painting. Sound interesting? Read on to find out more!

How to view the Stereoscopic paintings

While looking at the center of the stereoscopic pair, place your finger about 

halfway between you and the screen. If you converge your eyes to focus on 

your finger you will notice the images on the screen begin to overlap. 

Adjust your finger’s position until the images completely overlap. Because 

you are still focusing on your finger, the images on the screen will be 

blurred.

 

The trick is to remove your finger and allow yourself to focus on the screen 

without uncrossing your eyes. Done correctly, you will see three images on 

the screen. The center image will have depth and the two outer images will 

not. 

Your brain translates the disparity between the images that have 

overlapped into the experience of depth. 

James shares a selection of his sketches and started pieces with us in this month’s 
sketchbook. James is a great believer in getting straight in to Photoshop and putting 

some color down, and we can see in his images how he can turn a dash of color 
here and there into a great finished image.

This month we feature:

Ivan Kash

Ignacio Bazan Lazcano

Andreas Rocha

Boco

Sergey Musin

Jxing

Aziz Maaqoul

Seyyed Ghassem

Bradford Rigney

Daarken

Concept art for computer games is a fascinating field and an industry that a lot of aspiring digital artists would love to be involved with. This 

tutorial series has been written by some of the biggest and best names in the gaming industry, who will guide us through the way they would 

tackle the three main areas where concept work is required: environments, characters and accessories. The artists involved in this series have 

created a games brief themselves and are free to create their own vision of the description. They will reflect on the steps they choose to take 

from the point of receiving the brief up until they have created a completed concept for their required section.

Chapter 4: Characters | Bart Tiongson 

Futuristic soldiers and marines appear in many pieces of digital art. We see them 

in huge sci-fi scenes or even as a lone soldier wandering in a deserted landscape. 

They regularly feature in first person shooter computer games and even on the 

covers of books and comics. In this tutorial series our artists will be showing us 

how to create an original futuristic soldier that could live and thrive in some of the 

different environments a marine may face. The artists will also explore different 

methods of creating futuristic and organic armour and weaponry.

Chapter 1:  Evolved Future Marine | Svetlin Velinov | July 10 

Chapter 2:  Hot Planet Hydro Marine | Ignacio Bazan Lazcano | Aug 10 

Chapter 3: All-Terrain Marine | Richard Tilbury | Sep 10

Chapter 4: Female Marine | Alex Ruiz | Oct 10

If anyone knows about digital painting techniques it is Yang Xeuguo as he is an art teacher at a 

university in China. In this Making Of, Yang doesn’t only share his thought process behind this 

amazing surreal art, but also gives great advice on some of the fundamental art subjects.

“Pay attention to the 
changes of highlight on 
the subject, whether it is a 
rough or glossy surface”

Custom brushes are not only a great way to increase the speed at which a painting can be completed, but can also create an effect that would 

otherwise be impossible. They can be used in many different types of scene, but many would argue that they become most useful when 

creating a space scene. In space many items need replicating or reproducing in vast quantities, which can be difficult, but custom brushes can 

make this process much easier and simpler. In this series the artists involved will be showing you how to create brushes to improve your scene 

and how to use them to the best effect.

– Free Brushes

Chapter 01:  Asteroid Belt | July 2010

Chapter 02:  Egyptian Sci - Fi Scene | August 2010

Chapter 03:  Night-Time Sci-Fi City Battle | September 2010

Chapter 04:  Underground Corridor | October 2010

Chapter 05:  Sci-Fi Ruins | November 2010

Chapter 06:  Underwater City | December 2010

With the release of 3DTotal’s book, Digital 

Art Masters: Volume 4, we have some ex-

clusive chapters for you...

This is more than just an artwork book. 

Not only does it feature full-colour, full-

page images, but each artist has given a 

detailed description, in their own words, 

of the creation process behind each piece 

of published artwork. And they’ve done it 

especially for this book! 

This month we feature:
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another fantastic insight into working in the games industry, and shows us 

how to create fast and original concepts in Photoshop. 

We stick with the same subject matter for this month’s Custom Brushes 

for Sci-Fi tutorial. Roberto. F. Castro shows us ways to create brushes 

to help with our workflow and overall appearance of your work, and in 

this issue he concentrates on vents and wires, and shows a great way of 

creating volumetric light using a custom brush.

Moving away from Sci-Fi and on to Fantasy, this month’s creature 

from folklore is a Fairy and showing us how to paint them is Nykolai 

Aleksander. Nykolai is full of tips and tricks, including a cool way to create 

a color palette. Fairy’s are something that we are very familiar with, but 

Nykolai puts an interesting and modern twist on the subject.

Well there  is plenty in there to keep you going, have fun!

http://www.2dartistmag.com


Setting up your PDF reader 
For optimum viewing of the magazine it is recommended that you have 

the latest Acrobat Reader installed.  

You can download it for free here:  DOWNLOAD!   

To view the many double-page spreads featured in 2DArtist magazine, 

you can set the reader to display ‘two-up’, which will show double-

page spreads as one large landscape image: 

   

1. Open the magazine in Reader;   

2. Go to the View menu, then Page display; 

3. Select Two-up Continuous, making sure that Show Cover 
Page is also selected.

Get the most out of your 

Magazine!
If you’re having problems viewing the double-page spreads that we 

feature in this magazine, follow this handy little guide on how to set 

up your PDF reader!

http://www.adobe.com/products/acrobat/readstep2.html


page 4www.2dartistmag.com Issue 058 October 2010

Roberto F. 
Castro

An architect and visual artist; he 

has won awards in architecture 

and design and is the author 

of several architectural 

projects. As a visual artist he uses both traditional 

and digital techniques alike, and he develops 

works incorporating digital painting, concept art and 

animation. A great part of his work is focused on 

architectural environments, futuristic design, and 

character/creature design. 

http://robertofc.com/

contact@robertofc.com

ContributorsContributors

Contributing Artists
Every month many artists around the world contribute to 3DCreative and 

2DArtist magazines. Here you can find out a bit more about them! 

If you would like to be a part of 3DCreative or 2DArtist magazine, please 

contact: simon@3dtotal.com

Yang 
Xueguo
Yang Xueguo comes from 

Kunming, China. He started 

painting when he was a little 

boy and now is an art teacher 

at an art university. After graduating from university 

he decided to engage in 3D animation and digital 

painting. Yang prefers fantasy and surreal arts, and 

usually paints digitally, but plans to do some oil 

painting in the future. 

 

http://seedsfromhell.blogspot.com

blur1977@126.com

Theo   
Prins 
A young artist with a passion 

for environments, he works 

internationally as a freelance 

concept artist and travels 

frequently in search of inspiration for his own work. 

His latest projects include a growing collection of 

stereoscopic paintings and he’s currently in the 

process of creating an illustrated book. 

 

 

http://www.theoprins.com/

theo.w.prins@gmail.com

Nykolai 
Aleksander

A UK-based freelance character 

illustrator and portrait painter, 

she’s been working in the CG 

field for the past eight years, 

with publications in several Ballistic Publishing books 

and 3Dtotal’s ‘Digital Art Masters’ series, as well as 

numerous magazines around the world.

http://www.admemento.com 

x@admemento.com

Bart  
Tiongson 
Bart was born in the Philippines 

and raised in Toronto, 

Canada. Currently employed 

as a concept artist at Robot 

Entertainment, Bart was the lead artist on Halo 

Wars at Ensemble Studios and has over 10 years of 

industry experience.  Bart loves to eat! 

 

http://riceandeggs.blogspot.com/

BTiongson@RobotEntertainment.com

http://www.2dartistmag.com
http://robertofc.com/
mailto:contact@robertofc.com
mailto:simon@3dtotal.com
http://seedsfromhell.blogspot.com
mailto:blur1977@126.com
http://www.theoprins.com/
mailto:theo.w.prins@gmail.com
http://www.admemento.com
mailto:x@admemento.com
http://riceandeggs.blogspot.com/
mailto:BTiongson@RobotEntertainment.com


http://www.animationmentor.com/?utm_source=3DTotal&utm_medium=digitalmag&utm_content=SpikeBungee&utm_campaign=LeadGen


“I spend a lot of time 
biking around with my 
laptop, sitting in different 
places and painting”

Theo Prins is a fascinating digital artist living in Washington USA. He’s 

spent periods of his life in a variety of different and diverse locations around 

the world, which have clearly influenced his art, and he’s also a pioneer of 

Stereoscopic painting. Sound interesting? Read on to find out more!

How to view the Stereoscopic paintings

While looking at the center of the stereoscopic pair, place your finger about 

halfway between you and the screen. If you converge your eyes to focus on 

your finger you will notice the images on the screen begin to overlap. 

Adjust your finger’s position until the images completely overlap. Because 

you are still focusing on your finger, the images on the screen will be 

blurred.

 

The trick is to remove your finger and allow yourself to focus on the screen 

without uncrossing your eyes. Done correctly, you will see three images on 

the screen. The center image will have depth and the two outer images will 

not. 

Your brain translates the disparity between the images that have 

overlapped into the experience of depth. 
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Theo Prins Interview

Interview with Theo Prins

Hi Theo, it’s great to meet you and thanks for 

agreeing to be interviewed by 2DArtist. We 

usually start with an obvious one to get the ball 

rolling. Can you tell us a little about yourself? 

How did you end up in the digital art industry?

For most of my life I’ve been creating imaginary 

environments with pen/pencil, paint, clay and 

sometimes cardboard. I’ve always been focused 

on places. Among other things, flight has always 

fascinated me. I used to draw lots of airplanes. 

In my early teens I decided to pursue a pilot 

license and earned money by drawing airplane 

portraits for pilots at the local airport. This ended 

abruptly when I was shown a graphics tablet in 

high school. From there on out I painted digitally 

and became quite inspired by the sci-fi realms of 

concept artists. I ended up creating a Deviantart 

profile and posted frequently on the Sijun 

forums. Through this I got my first job at CCP 

games in Iceland.

I can tell by some of your paintings that you 

must be well travelled. Which parts of the world 

would you say have influenced you the most 

and is there anywhere that you would like to go 

that you think will be inspirational?

I’ve lived in small, quiet places by the water 

for most of my life, in the US and in Holland. 

Despite this, or perhaps because of this, I 

wound up with a fascination for dirty sprawling 

cities. So over the past three years I’ve fed this 

habit in my art by traveling to those sorts of 

places. Several years ago I had the wonderful 

experience of living in Seoul, South Korea, 

working for Reloaded Studios. In early 2009 I 

spent three months in Vietnam and Thailand 

traveling with my laptop, sketching and working 

on my stereoscopic paintings. It’s definitely the 

lively density and the visual chaos that I love 

about cities in Asia. Sadly, many of these places 

are being scraped away to make room for new 

apartment buildings. I’m on a mission to see the 

old world before it disappears. 

http://www.2dartistmag.com
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This is the question I have been looking forward 

to asking: where did you get the idea to create 

stereoscopic paintings and how do they work?

After taking many wobbly stereoscopic photos 

some years back, I became curious about the 

possibilities of mimicking stereoscopic depth 

in paintings. It all comes down to creating two 

slightly different perspectives of a scene and 

presenting these two perspectives to each eye 

separately so that they overlap in our vision. 

Typically I start off by cutting a painting into 

hundreds of pieces in Photoshop. I label all 

these pieces by their location on the canvas and 

briefly describe what they are. I then duplicate 

the painting and set it next to the original. Either 

by crossing my eyes or using a viewer, I merge 

the two images in my visual field and shift each 

little piece in the duplicate painting to create a 

second slightly different perspective.  Depending 

on which direction I move objects in the painting 

they will appear to move farther away or closer. 

It feels a lot like sculpting, actually. There’s 

definitely the feeling that I’m manipulating 

something physical in 3D space. 

It’s also fun to exaggerate the distance between 

the two perspectives, simply by shifting each 

piece farther. This creates the illusion of a 

miniature world, or that we, as viewers, have 

eyes very far apart like some giant creature. I 

http://www.2dartistmag.com
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highly recommend shooting two photos a few 

seconds apart from an airplane. Viewing the two 

photos as a stereoscopic pair will create this 

miniature world effect because the plane has 

moved a substantial distance by the time one 

snaps the second photo. 

Can you tell us a little about the process you use 

to create an image? And how does this need 

to change if you are creating a stereoscopic 

painting?

Sometimes an image will flash to mind when 

I’m exploring, say, a city. The experience of the 

image can be very vivid and it usually causes 

me to drop everything I’m doing and race back 

to my work station, or pull out a sketch pad and 

jot down as much of the composition and color 

relationships as I can. I like grabbing all the 

opportunities I can to paint. 

Other times, I’ll start a painting with the goal 

of creating a complete mess so I can find a 

composition within that mess. I’ll deliberately 

set myself up for happy accidents. Surprising 

compositions can come along that might not 

have been imagined beforehand. 

“Sometimes, an image will 
flash to mind when I’m 
exploring, say, a city.”

http://www.2dartistmag.com
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When I clean up a painting I define certain key 

shapes just enough for the mind to take off and 

fill in the rest. I think our brains are very powerful 

when it comes to filling in details that are only 

loosely suggested, or that the artist didn’t even 

intend. This can be good or bad depending on 

the purpose of the image. There are of course 

times when I want to be more deliberate with 

what is communicated in the image, particularly 

with freelance work. However, in my own work I 

like the “it can be a dog or a car” approach. 

My stereoscopic painting process has actually 

infiltrated my regular 2D process quite a bit. 

There can be emptiness in the 3D space if I 

convert just any 2D composition to stereo. More 

so than a 2D composition, I feel a stereoscopic 

composition requires each little object in the 

painting to be more independent and interesting 

in itself. This is because each object can be 

viewed at its own depth plane, just as we 

view the real world. Objects in a 2D painting 

sometimes rely on being viewed flat and 

compressed with everything else in the painting 

to convey the fullness and complexity of the real 

world. Additionally, because I have stereoscopic 

depth at my disposal, I almost subconsciously 

place less importance on conventional 

depth cues like atmospheric perspective. 

“It’s challenging to carry 
through the looseness of a 2D 
painting when it’s converted 

to stereo.”

http://www.2dartistmag.com
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When combined with my tendency to make 

each object a potential point of focus, my 

stereoscopic paintings can appear a bit cluttered 

when viewed in 2D. All in all, it’s challenging to 

carry through the looseness of a 2D painting 

when it’s converted to stereo. 

As a freelance concept artist you must have 

worked on various different projects. What 

would you say has been your favorite project to 

date? And are there any projects you would like 

to work on in the future?

I haven’t really worked on a large variety of 

different commercial projects at this point, but 

within the projects that I have worked on there’s 

been much variety. Currently I’m really enjoying 

the work I’m doing for Reloaded Studios. I’ve 

been with their project from an early stage so 

it’s been a great experience to see the concepts 

evolve, plus the art direction gives me freedom 

as an artist. As for the future, I don’t know 

what’s out there and I’m open to surprises. In 

the realm of personal projects, I want to keep 

developing my stereoscopic paintings and see 

where they take me. 

I have always thought that where you live 

and the environment that surrounds you will 

influence your art and that is certainly clear in 

your case. But beyond that, would you say that 

there is a specific artist or style of art that has 

influenced you?

When I first started working digitally I was 

http://www.2dartistmag.com
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http://www.2dartistmag.com
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http://www.2dartistmag.com
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definitely influenced by the whole speed painting 

movement and Craig Mullins’s work in particular. 

Then, for quite some time, I pulled myself away 

from the internet. I was spending too much time 

on the computer and it wasn’t healthy. 

Something that I have realized over a period 

of time is that a lot of artists we interview 

started down one career path and later turned 

their back on it to take up a career in digital 

art. Is there any advice that you would give to 

someone who was thinking of taking that step? 

And do you ever think about where you would 

be now if you had pursued a career as a pilot?

The physical reality of working behind a 

computer for hours on end results in a kind of 

sluggishness that really doesn’t support the 

creative process. As a balance, I’m finding it 

helpful to continually work in different locations. 

I spend a lot of time biking around with my 

laptop, sitting in different places and painting. 

New ideas come along and I’ve become more 

flexible in the way that I work. And after years 

of working purely digitally, I’m also working 

with pen and pencil again. This has been very 

refreshing.

I don’t often think of where I’d be if I had 

become a commercial pilot. The idea seems 

quite alien to me now. The idea became alien to 

“The physical reality of 
working behind a computer 
for hours on end results in 
a kind of sluggishness that 
really doesn’t support the 

creative process.”

http://www.2dartistmag.com
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me back then, and that’s what made it okay to 

quit. Although I do think that occasionally flying 

for pleasure would still be very fun.

I understand there is an exhibition in America 

that displays a lot of your stereoscopic paintings. 

How did that come about? Do you think that 

having a traditional exhibition of digital art 

improves people’s general impression of the 

subject and raises its profile?

Yes, the exhibitions in the 3D Center of Art and 

Photography in Portland, Oregon, USA. It’s a 

cozy museum and gallery showcasing antique 

and contemporary stereoscopic imagery. I made 

good friends with someone in South Korea who 

was coincidentally very much into everything 

stereoscopic. He pointed me towards the 3D 

Center as an outlet for stereoscopic art. 

I’ve had a few digital art shows over the 

years and people have been very supportive 

and curious about the medium. So, from my 

experience, I’d say having a traditional show 

has improved at least someone’s impression. 

Digital art is just new, and people I’ve spoken 

to often times don’t know it’s possible to “draw” 

and “paint” on the computer. 

One thing that I really enjoy when I am looking 

through your portfolio is your ability to come up 

with unique ideas. Your overall style of painting 

is really quite different and recognizable and the 

stereoscopic paintings are obviously unique. 

How important do you think it is to stand out 

and be able to come up with original ideas and 

styles?

In my personal work, I don’t place so 

much value on uniqueness by itself. I think 

purposefully trying to be unique can get in the 

way of the creative process. To me, it implies 

that one would be spending time carefully 

avoiding a whole array of already existing styles 

and ideas just to find that elusive original one. 

If uniqueness is to be the result of any kind of 

artistic process it’s probably by surprise and 

without much deliberation. 

I’m drawing what inspires me by following 

mysterious compulsions to draw certain things 

in a certain way. I’m not too controlling and the 

results are often surprising. I don’t let any pre-

conceived visions I might have of a painting limit 

the end result. Occasionally something unique 

might result, but it’s not my goal. 

I often find that although artists can be very 

quiet and humble about their ambitions, they 

are, in general, very ambitious. You seem 

to have achieved a lot in a short space of 

time, so what would you say is your greatest 

achievement to date and do you have any goals 

artistic or otherwise?

I’m very happy to have kept drawing and 

painting since childhood. There were numerous 

times when I could have let go of this habit.  

When I first moved back to the US from the 

Netherlands at age 13, it took me several 

years to get back into drawing. I became 

very passionate about flying and I was slowly 

forgetting about my art. Eventually I came 

around to digital art and that’s what really 

brought back my creative drive. 

http://www.2dartistmag.com
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As for my goals, an illustrated book and an 

animation have been brewing in my head for 

years. Every now and then I have intense two 

week sessions where lots of pieces slide into 

place. This has been happening more frequently 

as of late. Developing this project is becoming 

my goal.

Thanks for agreeing to be interviewed by 

2DArtist. You really are a fascinating artist and 

the team and I have really enjoyed looking at 

your stereoscopic paintings. I hope to see a lot 

more from you in the future.

You’re welcome. I’ve known about 3DTotal for 

a long time, so I’m happy to have taken part. 

Thank you!

Theo Prins
For more information please visit:

http://www.theoprins.com/

Or contact them at:

theo.w.prins@gmail.com

Interviewed by:: Simon Morse

http://www.2dartistmag.com
http://www.theoprins.com/
mailto:theo.w.prins@gmail.com
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All Tutorials Are Now Available 
As DVDs, Digital Downloads,

And Part of The Online Training Subscription

www.thegnomonworkshop.com

In this two volume series, Scott Patton shows the processes he uses to 
create a 3D character for feature films. The first volume explores 
Patton's fast and efficient method for concept sculpting, skipping the 
2D sketch phase all together and designing the character entirely 
within ZBrush®. He covers everything from blocking out the forms 
and fleshing out the muscles, to adding props, detailing with alphas 
and posing the character. The second volume covers methods for 
crcreating a final color rendering using ZBrush and Photoshop®. Patton 
shows how he squeezes the most from ZBrush’s powerful renderer to 
create both a wide and close-up shot of the character. He then shares 
creative Photoshop tips and tricks to quickly get to a finished piece of 
concept art from the ZBrush renders, covering topics such as adding 
and refining skin texture, hair, eyes, shadows and scars. Patton also 
discusses how to create backgrounds that enhance the character and 
ovoverall composition.

3D CHARACTER DESIGN SERIES
WITH SCOTT PATTON

LEVEL UP YOUR DIGITAL SCULPTING SKILLS

TRAIN WITH KILLER ARTISTS

http://www.thegnomonworkshop.com/subscription


James shares a selection of his sketches and started pieces with us in this month’s 
sketchbook. James is a great believer in getting straight in to Photoshop and putting 

some color down, and we can see in his images how he can turn a dash of color 
here and there into a great finished image.
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James Wolf Strehle Sketchbook

Sketchbook of 
James Wolf 
Strehle

As a digital artist I don’t think I really have what you 

would consider a conventional “sketchbook”. It is 

a cluttered pile of folders and files, but the heart of 

this digital mess contains much of what the artist 

is about. When you do open it up you are opening 

a folder of a thousand unfinished fantasies. It is 

a world of undiscovered lands and characters 

searching for a purpose. I have so many unfinished 

works that it was hard to make a selection for this 

article, but I’ve managed to scrounge up a few to 

write some words about. 

When it comes to sketching environments I usually 

don’t get much further than a few scribbled lines 

before filling the screen with color. The reason is 

that environments have a lot more freedom than 

figurative work, because you don’t have to be 

completely accurate to be believable, so I let the 

textures and brush work fill in the details for me 

(Fig.01). 

I usually reserve slightly more involved 

environment sketches for clients, because there 

tend to be more restrictions involved and there is 

no point in wasting time adding color in until you 

know you are on the right track (Fig.02). 

http://www.2dartistmag.com


With figurative work I tend to spend more time with 

the character’s anatomy. I don’t spend too much 

time perfecting it, but I try getting the anatomy close 

enough that I can use it as a guide, because I can 

always tweak and adjust during the painting stages. 

Towards the end of the sketching process I fill 

in the major shapes to aid in the painting later, 

because I can quickly select the masks under the 

Channels tab later. This allows me to make large 

color washes and brush strokes without having to 

be precise, at least until a later point in the painting 

(Fig.03 – 04). 
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Lately I’ve been jumping right into the landscapes 

with full color because I find the process of 

experimentation to be very exciting. The time involved 

is still low and it allows me to get a more finished look. 

I also like getting the color in early in case I run out 

of time and the sketch ends up getting lost in my pile 

of unfinished work. I can open it up and immediately 

know what I was going for when I originally started 

the image (Fig.05 – 06).

http://www.2dartistmag.com


I have also been doing this with smaller 

illustrative work, because I’ve been trying to 

loosen up my style and not be so nitpicky 

about the small stuff. It lets me keep the image 

fresh and I don’t get caught up in following the 

sketched guidelines (Fig.07 – 08).  





This is a small selection of my “sketchbook” but 

hopefully I was able to give you an idea of what 

goes on behind the scenes that are normally 

kept in the shadows (Fig.09 – 10). If you would 

like to see the finished versions of many of 

these sketches, feel free to check out my art 

blog at: Jameswolfart.blogspot.com. Thanks for 

looking! 





James Wolf 
Strehle
For more information please visit:

http://www.jamiestrehle.com/

Or contact them at:

jameswolfstrehle@yahoo.com

http://www.jamiestrehle.com/
mailto:jameswolfstrehle@yahoo.com
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VFS animation & ViSual eFFectS alumni creditS include 9 Mike Dharney, Animator 2012 Jamie Bowers, Texture Artist 

Zeke Norton, Previsualization Supervisor | Anuj Patil, Senior Technical Director | Christine Peterson, Digital Compositor 50 cent: 

Blood on the Sand (VG) Giorgio Bertolone, Creature Technical Director aliens in the attic Rex Ahn, Pre-Visualization 

Lead | Craig Calvert, CG Supervisor | Julianna Kolakis, Character Designer | Ben Sanders, Supervising Animator | Rommel Shamoun, 

Compositor | Noel Wright, Digital Compositor | Adam Yaniv, Animation Supervisor alvin & the chipmunks: the Squeakuel 

Nicholas Augello, Technical Animator | Christopher Downs, Technical Animator | Amy Lu, Animator | Adam Yaniv, Animation 

Supervisor amelia Armando Velazquez, Digital Compositor | Clement Yip, Animator america’s army 3 (VG) Matthew Turner, 

Artist angels & demons Craig Calvert, Pre-Visualization Artist | Jessica Wan, Lead Rotoscope Artist | Noel Wright, Digital 

Compositor armored Riley Benard, Digital Compositor | Yuta Shimizu, Visual Effects Artist astro Boy Andreas Hikel, Layout Artist 

Kim Ooi, Animation Director avatar Michael Cozens, Lead Animator | Tamir Diab, Technical Director | Aaron Gilman, Character 

Animator | Alfredo Luzardo, Layout Technical Director | Ben Sanders, Animator  the Beatles: rock Band (VG) Mike Krentz, UI Artist 

Brütal legend (VG) Marke Pedersen, Senior Artist case 39 Riley Benard, Digital Compositor | Craig Calvert, CG Supervisor | Matthias 

Lowry, Visual Effects | Fion Mok, Matchmove Artist | Teh-wei Yeh, Matchmove Artist cirque du Freak: the Vampire’s assistant 

Nicholas Augello, Technical Animator | Julianna Kolakis, Character Designer | Ai Saimoto, Lighting Lead cloudy with a chance of 

meatballs Andrew Lawson, Animator | Arun Ram-Mohan, Senior Color and Lighting Technical Director coraline Brian Demoskoff, Animator 

a christmas carol Kirk Chantraine, Motion Capture Technical Director | Joel Pennington, Motion Capture Technical Director | Shraga 

Weiss, Character Modeler | Brent Wong, Character Modeler district 9 Neill Blomkamp, Director/Co-Writer | Jelmer Boskma, Modeler | Robert 

Bourgeault, Lighting Lead | Freddy Chavez, Visual Effects Compositor | Dominic Cheung, Lighting Technical Director | Paul Copeland, Visual Effects 

Artist | Anthony Di Ninno, Animator | Brian Harder, Creature Rigger | Bernhard Huber, Effects Animator | Brett Ineson, Motion Capture Supervisor 

Steve Johnston, Render Wrangler | Patrick Kalyn, Animator | Bernhard Kimbacher, Visual Effects Data Coordinator/Compositor | Julianna Kolakis, 

Creature Texture Painter | Adam Marisett, Visual Effects Artist | Nikolai Michaleski, Compositor | Brendon Morfitt, Digital Artist | Fernando 

Pazos, Animator | Dan Prentice, Visual Effects Artist | Mike Rhone, Visual Effects Artist | Cesar Rodriguez Bautista, Digital Paint & Roto Artist 

Cynthia Rodriguez del Castillo, Digital Paint & Roto Artist | Marc Roth, Visual Effects Artist | Derek Stevenson, Matchmove Lead | James Stewart, 

Creature Supervisor | Richard Sur, Lighting Technical Director | Anna Tonrungroj, Digital Compositor | Shawn Walsh, Visual Effects Executive 

Producer | Joey Wilson, Modeler/Texturer | Samson Wong, Matchmove Artist drag me to Hell Thomas Schelesny, Visual Effects Supervisor dragon 

age: origins (VG) Bobby Bath, Character/Creature Artist | Ryan Lim, Lead Creature Character Artist | Herbert Lowis, Artist | Brian Sum, Concept Artist 

Nathan Zufelt, Cinematic Animator escape from Planet earth Giorgio Bertolone, Creature Technical Director | Anthony Di Ninno, Layout Artist | Craig 

George, Head of Story | Gary Hendry, Layout Artist | Nicholas Smolyn, Layout Artist eureka Anuj Patil, Lead Compositor | Mike Rhone, Visual Effects Artist 

Fast & Furious Ben Dishart, Texture Artist | Armando Velazquez, Digital Compositor the Final destination David Yabu, Animator G-Force John Iskandar, 

Lighting and Compositing TD | Ken Kaiser, Animator | Hyun Chul Jung, Animator | Andrew Lawson, Animator | Phan Wiantrakoon, Animator Ghostbusters: the 

Video Game (VG) Giorgio Bertolone, Creature Technical Director | Winston Fan, Compositor | Harry Liu, Junior Motion Capture Editor | Jessica Mih, Modeler | Maya 

Zuckerman, Visual Effects Artist Gi Joe: the rise of cobra Jelmer Boskma, Modeler | Patrick Conaty, Digital Compositor | Ben Dishart, Texture Supervisor | Aruna 

Inversin, Digital Compositor | Julianna Kolakis, Concept Artist/Modeler | Sean Lewkiw, Visual Effects Artist | Tom Piedmont, Digital Artist | Jeremy Stewart, Senior 

Animator | Jeff Tetzlaff, Lead Modeler | Jessica Wan, Lead Rotoscope Artist Grey Gardens Armando Velazquez, Digital Compositor Halo 3: odSt (VG) Bartek 

Kujbida, Cinematic Animator Harper’s island Steve J. McLeod, Digital Compositor Harry Potter and the Half-Blood Prince Harry Mukhopadhyay, Lead Effects 

Technical Director | Pietro Ponti, TD Generalist | Gia Sadhwani, Digital Effects Artist | Kieran Tether, Digital Artist | Teh-wei Yeh, Lighting TD ice age: dawn of the 

dinosaurs Scott Lemmer, Animator | Thom Roberts, Animator | Brent Wong, Modeler invictus Christopher Ahrens, Lighting Lead | Geoffrey Hancock, Visual Effects 

Supervisor | Sean Lewkiw, Digital Effects Supervisor | Jason McKeeman, Lead Technical Animator | Farhad Mohasseb, Compositor | Michelle Skrzyniarz, Matchmove 

Artist | Jose Yapor, Animator Killzone 2 (VG) Andrea Arghinenti, Technical Artist King of the Hill Michael Loya, Director Knowing Tim Rowlandson, Rigging 

Technical Director | Richard Sur, Lighting Technical Director land of the lost Nicholas Augello, Massive Technical Director | Tony Etienne, Lighting Supervisor 

Amy Lu, Character Animator law abiding citizen Freddy Chavez, Compositor | Veronica Marino, Compositor | James McPhail, Effects Animator | Jacob Curtis 

Miller, Matchmover | Jay Randall, Visual Effects Supervisor | Derek Stevenson, Matchmover | Shawn Walsh, Visual Effects Executive Producer the league 

of Super evil Daphne De Jesus, Compositor | Barry Karnowski, Animation Supervisor the lord of the rings: conquest (VG) Michelle Lam, Lead 

Character Artist the lovely Bones Michael Cozens, Previs Animator monsters vs. aliens Jiyoung Lee, Texture Artist night at the museum: Battle of 

the Smithsonian Rex Ahn, Previsualization Lead | Nicholas Augello, Technical Animator | Christopher Downs, Technical Animator | Joshua Herrig, Lead 

Lighter | Zeke Norton, Previsualization Supervisor | Ai Saimoto, Lighting Lead | Ben Sanders, Supervising Animator | Derek Stevenson, Previsualization 

Artist | Joey Wilson, Previsualization Artist | Adam Yaniv, Animation Supervisor orphan Francisco Moncayo Moreno, Digital Artist | Shawn Walsh, Visual 

Effects Executive  Producer Paul Blart: mall cop Riley Benard, Digital Compositor Planet 51 Sandro di Segni, Senior Effects TD | Jorge Kirschner Torres, 

Modeler | Gianfranco Valle, Effects Animator Prototype (VG) Harry Ahn, Lead Cinematics Animator | Bobby Bath, Lead Character Artist Punch-out!! 

(VG) Nelson Garcia, Concept Artist Pushing daisies Scott Dewis, Visual Effects red Faction: Guerrilla (VG) Dilber Mann, Project Manager resident 

evil 5 (VG) Jacob Palmer, Animator rock Band unplugged (VG) Mike Krentz, Artist Sanctuary Julie Bergman, Animator | Mladen Miholjcic, Visual Effects 

Artist Shorts David Yabu, Animator Sorority row Mike Rhone, Visual Effects Artist Star trek Aruna Inversin, Digital Compositor | Tom Piedmont, Digital 

Plate Restoration | Kieran Tether, Digital Artist | Teh-wei Yeh, Digital Artist Stargate universe Daphne De Jesus, Digital Compositor | Julianna 

Kolakis, Character Designer | Daniel Osaki, Lead 3D Modeler | Anna Tonrungroj, Digital Compositor Supernatural, Daphne De Jesus, Digital 

Compositor Surrogates Anthony Di Ninno, Animator | Joshua Herrig, Lighting Artist/Look Dev Artist | Matthias Lowry, Digital Compositor | Laurie 

Powers, Compositor | Teh-wei Yeh, Digital Artist tales of monkey island (VG) Jason Findley, Character Artist terminator Salvation Geeta 

Basantani, Digital Matte Painter | Teh-wei Yeh, Lighting Technical Director transformers: revenge of the Fallen Allen Holbrook, Animator | Aruna 

Inversin, Compositor | Stephen King, Animator | Henri Tan, Creature Technical Director | Kieran Tether, Digital Artist | Teh-wei Yeh, Digital Artist 

the twilight Saga: new moon Dominic Cheung, Lighting Technical Director uncharted 2: among thieves (VG) Mike Yosh, Lead 

Animator underworld: rise of the lycans Pearl Hsu, 3D Artist | Lon Molnar, Visual Effects Production Executive up Bill Watral, 

Visual Effects Artist Warhammer 40,000: dawn of War ii (VG) Ian Cumming, Senior Artist | Allan Dilks, Artist | Nathan Hocken, 

Lead Animator | Christine Hubbard, Artist | Claire Roberts, Artist | Jefferson Takahashi, Artist Watchmen Ori Ben-Shabat, Compositor 

Jelmer Boskma, Previs Modeler | Freddy Chavez, Compositor | Dominic Cheung, 3D Artist | Ben Dishart, Texture Artist | Ty Duperron, 

Modeler | Pearl Hsu, 3D Artist | Bernhard Kimbacher, Digital Artist | Sean Lewkiw, Technical Head of 3D | Matthias Lowry, Digital 

Compositor | James McPhail, Digital Effects Artist | Jacob Curtis Miller, Digital Artist | Lon Molnar, Visual Effects Supervisor | Harry 

Mukhopadhyay, Lead Effects TD | Cynthia Rodriguez del Castillo, Digital Artist | Derek Stevenson, Matchmove Artist | Shawn Walsh, 

Visual Effects Supervisor | Samson Wong, Compositor Wheelman (VG) Laura Gorrie, Senior Animator Whiteout Armando Velazquez, 

Digital Compositor | Clement Yip, Animator Wolfenstein (VG) Jason Martin, Modeler X-men origins: Wolverine Geeta Basantani, 

Digital Matte Painter | Rommel Shamoun, Compositor | Jeremy Stewart, Previs Artist Zombieland Mike Rhone, Visual Effects Artist

VFS student work by thiago martins
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This month we feature:

Ivan Kash

Ignacio Bazan Lazcano

Andreas Rocha

Boco

Sergey Musin

Jxing

Aziz Maaqoul

Seyyed Ghassem

Bradford Rigney

Daarken
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Fields of Gold
Andreas Rocha

http://www.andreasrocha.com 

rocha.andreas@gmail.com

(Below)

The Claws of Space
Aziz Maaqoul

azizmaaqoul@yahoo.fr

(Above)
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A Hostile Takeover
Bradford Rigney

http://cryptcrawler.deviantart.com/ 

bradfordrigney@gmail.com

(Above)

The Day
Ignacio Bazan Lazcano

http://www.ignaciobazanart.com/ 

i.bazanlazcano@gmail.com 

(Below)
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Horned Dragon
Ghassem Farhany

http://www.gh-farhany.com 

gh.farhany@gmail.com
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Scene `3`
Ivan Kashubo 

www.kashivan.blogspot.com

ivankash.art@gmail.com

http://www.2dartistmag.com
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Persian Sky Palace
Boco

http://selsbram.blogspot.com

selsbram@hotmail.com

(Right)

Postapocalyptic Warior
Sergey Musin

http://www.samfx.com 

samfxi@gmail.com

(Left)

© 2010 BLUE GIANT ENTERTAINMENT
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Me, a Drawing Robot
Jxing

angusyap@hotmail.com
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Concept art for computer games is a fascinating field and an industry that a lot of aspiring digital artists would love to be involved with. This 

tutorial series has been written by some of the biggest and best names in the gaming industry, who will guide us through the way they would 

tackle the three main areas where concept work is required: environments, characters and accessories. The artists involved in this series have 

created a games brief themselves and are free to create their own vision of the description. They will reflect on the steps they choose to take 

from the point of receiving the brief up until they have created a completed concept for their required section.

Chapter 4: Characters | Bart Tiongson 



Game type: First person shooter  

Genre: Sci-Fi Year: 2300

The setting is Earth and the prison planet, Asturia. 90% of the game is 

on Asturia.
 

Plot summary: Lex Crane, a former police officer, is now the chief of 

security at Skye Global, the largest manufacturer of pharmaceuticals 

on the planet. Lex discovers something about the company he works 

for that he shouldn’t have, and this starts a chain reaction that causes 

him to be wrongly accused for the murder of his family and a local 

politician.  He is sentenced to life imprisonment on the prison planet of 

Asturia. On the prison planet he is constantly targeted by the criminals 

that he put there all those years ago, along with an unknown enemy 

within the prison walls hired by Skye Global. Lex was framed by Skye 

Global’s CEO, Lance Shepherd, and Shepherd is now trying to have him 

killed in a place where nobody will miss him or even realize he’s dead. 

Lex is trying to escape from the prison and return to Earth, where he’s 

convinced he can find the evidence to clear his name. Along the way he 

forms unexpected alliances and is disappointed by shocking betrayals.

The environment: The setting is dark and cold. The planet is basically a 

giant rock. There is no lush foliage or vast bodies of water. Instead there 

are pits of oil and sludge. The terrain has large, jagged rock formations 

jutting out sporadically throughout the landscape. The sky is constantly 

filled with flashes of green lightning, which brings on poisonous rain storms.

There is a giant prison facility that has been placed on the planet to house 

the galaxy’s most violent and evil criminal element. Escape is rarely ever 

attempted because of the sheer fact that outside the walls survival is not 

possible. The extremely harsh climate, along with the predatory dangers 

that exist on the planet, make it so that the prisoners would rather stay 

confined to prison. At least there is food, shelter, warmth etc., inside the 

jail.

Prisoners are forced to work as part of their sentence.  The labor camps 

are set up throughout the perimeter surrounding the prison. They are 

forced to mine for the oil that exists deep within the surface of the planet. 

Along with these intensely laborious tasks of digging and mining, the 

prisoners are also constantly expanding the facility to house yet more 

prisoners.  
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Concept Art for Games: 
Part 4 - Characters
Software used: Photoshop

There are various ways that I create characters. 

It all depends on the subject matter, the 

specifics of the character or even just the mood 

that I’m in at a certain time. But whether I’m 

using markers or graphite on paper or working 

digitally with Photoshop, one thing remains 

constant; I always do rough thumbnails to 

start off. It’s important to keep things loose 

and gestural in the initial sketches. Here I use 

different ways to create thumbnails (Fig.01).

Sometimes I’ll just “ink out” black solid shapes, 

while other times I’ll use a very light gray as an 

“under layer” and ink out the linear details. On 

another occasion I might start off smudgy and 

just roughly fill in the areas of the silhouette until 

I feel that I’ve nailed a decent initial design.

In this image I’ve narrowed down several of the 

thumbnails that I feel are not only a cool designs 

but also suit the personality of the character 

(Fig.02). I want to keep each of these “finalists” 

as different from each other as possible; this 

way it makes it easier for me to choose one 

specific design to go with.

I end up using elements from each design to 

come up with the final choice (Fig.03). I like 

different things about each and the end result 

merges them all in some way. I start thinking 

more specifically about the face and hair 

specifics. Lex Crane (Lexus is his full name 

and he has always hated the fact that his father 

named him after a car. His father’s name was 

Cadillac Crane) is a man in his mid 40’s and is 

very strong willed and stubborn. He is a haggard 

and cold, and while good hearted at his core, 

he has an exterior that would lead people to 

believe otherwise. Keeping this information in 

mind is very important. You can never lose sight 

of the personality of the character. I always try 

to imagine how the character would behave in 

http://www.2dartistmag.com
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certain situations. This helps me to visualize 

the different physical aspects of the person I’m 

designing.

With this in mind I commit to a specific face and 

decide to run with it (Fig.04). I can very easily 

spend too much time on any given design, 

whether it’s the face, the costume, a weapon 

etc. That is why it’s important to do various 

thumbnails then choose one and confidently 

move forward. Once you’ve decided which 

designs to go with you do your best to make it 

as polished and cool as possible. Whilst I work 

out the details of his uniform as Chief of Security 

at Skye Global, I am also thinking about and 

polishing the specifics on his face. I go back and 

forth between the two concepts to help keep 

my mind fresh as well as allowing one design to 

affect the other.

In these four images you can see the 

progression from a loose thumbnail to the final 

concept (Fig.05a). I use pretty dramatic lighting 

to accentuate his bone structure. Lex is a very 

strong individual, both in mind and body, and 

I feel that this has to be reflected not only in 

his body, but also his face. I draw very light 

construction lines to begin drawing the face. I 

break up the face into thirds keeping the eyes 

roughly in the center. 

When I first begin a front view of a face, I will 

rough out the area of the eyes, ears, nose and 

mouth (Fig.05b). I’ll then get a little tighter on 

the details on one side, then copy and flip the 

drawing to mirror the other side. This is for 

placement and proportion only. Nobody’s face is 

exactly identical on both sides, so it’s important 

to paint in the “imperfections” of one’s face to 

make it feel more realistic and believable. This is 

also how you show the character in one’s face.

After I’ve basically solidified the front view, 

I’ll use the same steps to create the sides 

and the ¾ front view as well (Fig.06). Unless 

there is something very unique and specific 

http://www.2dartistmag.com
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in the design of the rear view, it’s usually not 

necessary to draw this for most 3D modelers. 

It’s important not to spend time on unnecessary 

concept drawings, and it helps to know the 

ability and/or style of the modeler that will 

be building from your concept. For example, 

some modelers will need more information 

than others, while other artists work far better 

if you leave some room for interpretation. As a 

concept artist it’s crucial to be able to recognize 

when you need to do more or less work, and 

you have to be ready and able to draw out as 

much detail as the next artist may need.

This is the final image of the three angles of 

Lex’s face (Fig.07a). I’ve added some final 

touches like scars, and a robotic eye. This adds 

to the sci-fi vibe as well as emphasizes the fact 

that Lex is no ordinary individual.

This is the final image of Lex Crane as Chief of 

Security at Skye Global (Fig.07b).

I want to accentuate the fact that Lex is not your 

average “Joe”. So in this picture I am creating 

some rough elements of design on his nude 

body (Fig.08). I want to show that he is partially 

robotic. Maybe he was injured in the line of duty 

during planetary wars or during his stint as a 

global military soldier (Shock Troopers). 

I keep these drawings very loose since I feel 

that they are more for mood and tone. At this 

point it’s not certain whether or not we would 

even see Lex in this “mode” during the game. 

I feel that it’s still important to include these 

types of drawings because it helps the fiction to 

evolve. In the end there can never be too much 

information.

http://www.2dartistmag.com
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I render out the half human, half robot body a 

little bit further (Fig.09). In this picture I also try 

to show the physical stature of Lex. I want to 

show that he is very strong and muscular, even 

though he has the body of a man in his mid 40’s.  

Much like the previous images showing the 

nude front, I don’t spend too much time detailing 

the back (Fig.10 – 11). The idea being that we 

will most probably never see Lex completely 

naked. While this is the case, it’s still important 

to show what he would look like underneath 

his clothing to help the modelers, art director 

or game designers to understand your thought 

process and how and why the character looks 

like he does. Sometimes I’ll paint a grayscale 

gradation bar that goes from dark to light. This 

helps me to keep in mind to include different 

values. I want there to be a successful amount 

of contrast in the design. I don’t usually want 

any design to be overwhelmingly dark or light.  

Of course there are always exceptions to this 

rule depending on the specific design.

The final pose and design for the rear nude view 

(Fig.12).

I imagine that a large majority of the game 

will be played with Lex in his Combat Gear 

(Fig.13). Before Lex was wrongly imprisoned 

he was a decorated Shock Trooper, leading 

forces against enemies that threatened Earth’s 

security. I wanted to make sure that this armor 

and gear felt close enough to current day 

military wear so that the viewer would be able to 

relate to it, but at the same time have the design 

different enough and far enough removed, 

so that it conveyed a science fiction feeling. I 

started out with a blocky rough silhouette like 

always. It’s much easier to move forward with 

this design now that I have already created the 

body type and face of the character. Since we 

already have his face designed I decide to make 

this concept full gear including a helmet and 

face mask.  

I usually work initially in black and white. This 

helps me to focus primarily on the design 

without having to worry about color early on. I’m 

also able to keep a good degree of value range, 

which I feel is very important when designing 

http://www.2dartistmag.com


page 52www.2dartistmag.com Issue 058 October  2010

Chapter 4: Characters Concept Art for Games
characters (Fig.14a). Once I’m happy with the 

grayscale concept, I’ll put a subtle color overlay 

on it using either the Color brush or the Color 

Layer option. This way I’m able to preserve the 

original black and white design without the risk 

of losing it due to my color additions.

Once I have my color wash in there I also work 

on specific little details, like the scratches in 

the armor (Fig.14b). This helps to show he’s 

been in many battles. I also want to include not 

only contrast in values, but also in the shapes 

of the armor. I like to have small, medium and 

relatively large shapes in the designs. Again, 

this isn’t always going to be the case with every 

character.

These show more images that focus on 

attention to detail. Every little bit helps to make 

the final “sell” successful (Fig.15).

Here is the final design of Lex Crane in his 

Battle Gear as a Global Shock Trooper (Fig.16).

Ultimately there are many different ways to 

achieve the same goal. From a lower level, 

the goal of the concept artist is to convey and 

create an image that fits the description of the 

game designer. You must be able to visualize 

and bring to life the ideas of people that often 

are not imaginable beyond the written word.  

It’s important to be able to do this in a quick 

and timely manner as well as creating as many 

different ideas as necessary in order to satisfy 

the “client”.

From a higher level the concept artist must 

be able to create imagery and concepts that 

stand out from what has already been seen. 

Being unique is very difficult in today’s very 

competitive game’s industry. If you want your 

game to stand out visually from the rest of the 

games that are out there, it all starts with the 

concept. You are laying down the foundation 

of the entire game and your designs are 

responsible in a large way for deciding if the 

game is inviting or not. Of course the entire art 

team plays a crucial role in developing the look 

and each artist is equally responsible, but if the 

artwork from the concept side starts out bland 

or forgettable, then it makes the tasks that much 

more difficult for the rest of the team.

I hope that I was able to give you some insight 

into the pipeline and development of characters 

from the concept level of video games. While 

many different artists have different techniques 

and tricks of the trade, I always have and will 

maintain that the only thing that you truly need 

to succeed as a concept artist, is hard work, 

dedication, an open mind, and a passion for the 

craft!

Thanks for checking out my tutorial and please 

feel free to contact me with any questions or 

comments.

http://www.2dartistmag.com


page 53www.2dartistmag.com Issue 058 October  2010

Concept Art for Games Chapter 4: Characters

Bart Tiongson
For more information please visit:

http://riceandeggs.blogspot.com/ 

Or contact them at:

BTiongson@RobotEntertainment.com
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http://www.digitaltutors.com/3dtotalprize


Futuristic soldiers and marines appear in many pieces of digital art. We see them 

in huge sci-fi scenes or even as a lone soldier wandering in a deserted landscape. 

They regularly feature in first person shooter computer games and even on the 

covers of books and comics. In this tutorial series our artists will be showing us 

how to create an original futuristic soldier that could live and thrive in some of the 

different environments a marine may face. The artists will also explore different 

methods of creating futuristic and organic armour and weaponry.

Chapter 1:  Evolved Future Marine | Svetlin Velinov | July 10 

Chapter 2:  Hot Planet Hydro Marine | Ignacio Bazan Lazcano | Aug 10 

Chapter 3: All-Terrain Marine | Richard Tilbury | Sep 10

Chapter 4: Female Marine | Alex Ruiz | Oct 10
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Painting Futuristic marines - 
Female Marine
Software used: Photoshop

Introduction
First let me say that it was a pleasure doing 

this tutorial for the great team over at 3DTotal. 

Creating a tutorial can sometimes be a very 

easy thing for an artist, assuming they’re 

creating art that they’ve done many times 

before. This was not the case for me on this 

one!

I was asked to do one of four tutorials, the 

theme being “Futuristic Marines”. At first I 

thought, “cool, I’ll just create some badass 

marine, no problem”. Then I saw what the other 

artists were doing and well, the slightest bit 

of intimidation set in. Then I thought, “damn, I 

better do something real original or else this isn’t 

going to work!”

Thankfully, the gang at 3DTotal let us come up 

with our own vision of a futuristic marine. So 

one idea I suggested was, “a badass, post-

apocalyptic, superhot female marine”. They 

loved it, and I loved them for that, because I 

don’t do many finished pieces with females in, 

so this would certainly give me the opportunity.

This image was to be first and foremost, super 

sexy! Anatomy was going to play a big part, as I 

wanted to show as much of it as possible. 

As I progressed, I decided on a locker room feel, 

perhaps a post-battle hangout. But I also wanted 

it to have a model shoot vibe as well, hence the 

“posed” poses.

I used no references for the females except my 

trusty male anatomical sculpture (Fig.01).

During the painting, there came a point where I 

decided to take it from a comic looking “colored 

line drawing, to a full on painting. This meant 

removing the ink line and rendering the forms 

realistically.

Sketches 
As with most of the art I do, we’re going to start 

with sketches first. Most of the time I sketch 

right into Photoshop, but this time it’s basic pen 

on paper. There’s definitely a freedom in that...

no layers, no fancy brushes; just you, one tool, 

and your imagination. Since I already know the 

subject - a badass female marine - it’s easy to 

come up with several ideas. As I’m sketching 

away, I start thinking maybe I should do two 
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characters, and after some more sketching, I 

think, “why not a group of hot badass girls?”

 (Fig.02 - 06).

  

Deciding on Final Sketches 

In Fig.04 you can see the direction I’m taking 

the piece in. The sketch is not pretty, but at 

this point it is all about ideas and the overall 

concept. It has that locker room feel that I want. 

It’s also a little playful, and of course, sexy!

Scan and Clean Up
After scanning the drawings in and compiled 

them, the arduous clean-up process begins! 

Cleaning up a drawing in Photoshop can take a 

while as opposed to doing it on paper, but you 

do have a bit more control. I’m using a regular 

brush with a tapered edge to do the clean 

up on all the characters. This is not my usual 

process, as I like to go right into painting, but I 

wanted this tutorial to reveal more of my thought 

process. 
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Separation Using Lasso/Paths
I’ve got each character separated on their own 

layer, so I can’t compose the image by moving 

the characters around as I go along. During this 

process, I’m making Paths for the characters as 

well, to further fine tune the edges and overall 

silhouettes. When you make a path, you simply 

select the image either with the wand or by hand 

with the Lasso, and in the paths palette, click on 

Make Work Path from Selection. Once you’ve 

done that, you can now edit that path using the 

pen tool to refine the path. I’m editing the paths 

all the way through the painting process so I 

have precise control over edges and silhouette 

(Fig.07 – 10).

Quick Value Studies
When I’m working on a piece, I like to jump 

ahead using values (black, white, gray) and 

see how the composition reads. You can find 

mistakes in your drawings and composition 
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by doing this. This also helps break up the 

mundane clean up phase (Fig.11 – 13). 

Adding Color
This can simply be done by using overlay 

and soft light layers over your values. But you 

want to build up the color, because it can look 

very fake if you overdo it at the beginning. It’s 

better to start with very low saturation for the 

base color, and gradually build on it from there 

(Fig.14). 

Painting/Rendering Forms
This is where you take lines and turn them into 

forms. This is the main difference between 

drawings and paintings. Both have unique 

qualities about them, but just because you can 

do one well, doesn’t mean you can do the other. 

Anatomy
The one thing I stress to all my students (and 
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myself as well), is that learning anatomy is 

key in becoming a good artist. It’s important to 

understand where things connect, how it moves, 

and the overall form of the bone/muscle, etc. 

This is the one area, if you get it wrong, that 

can throw the whole painting off, which is why 

you have to put the time into taking life drawing 

classes, and studying and copying from books 

to get to grips with the basics. I’ve always said 

“if you can draw the figure well, then you’ll 

be able to draw animals well”. From there, 

creatures and robots will come much, much 

easier.

Details
This part of the process can be very fun, 

assuming you’ve done most of the hard work! 

The dog tags are a fun little detail that I have 

created in a separate file. You can then play 

around with drop shadow effects and bevel/

emboss effects (Fig.15 – 18). 

The rifle I’ve created for the main girl is 

composed of various machine and weapon 

photography that I’ve compiled earlier into a 

weapon asset sheet (Fig.19). You can add the 

Marine tattoos by using a clipart of the standard 

marine tattoo, and setting the layer blending 

mode to Overlay (Fig.20). I’ve brought in a few 

other images of mine to add subtle technology 

around the image (Fig.21). Finally, adding little 

things like highlights and reflections can really 

bring a piece to life, so remember to experiment! 
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Textures/Finishing Touches
I’m looking for a subtle ‘grungy’ quality to this, 

so let’s bring in grungy textures and set them 

to Overlay and Soft Light blending modes, 

erasing what you don’t. I’ve also decided to 

create an alternate image to make it look like 

an old vintage postcard, basically by taking it 

back to grayscale, and adding a subtle sepia 

tint (Fig.22). This was done using Adjustment 

Layers, found at the bottom of your layers 

palette (Fig.23 – 28).

Conclusion
I had a great time working on this, and as I 

mentioned before, this image was somewhat 

unusual for me. Most of my work is very 

conceptual; the artists I’m most compared to 

being H.R. Geiger and Andrew Jones (which is 

an absolute honor), though we see none of that 

sensibility here as I wanted to try something 

different. My point being, that you must 

challenge yourself as an artist, and that means 

as a human being as well. Try to incorporate 

new ideas all the time, study things like history, 

engineering, philosophy, and apply some of 

those concepts in your work. And of course, 

don’t forget to draw sexy ladies from time to 

time (Fig.29).

Now get back to creating art, my friends!    
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Alex Ruiz
For more information please visit:

http://www.conceptmonster.net/ 

Or contact them at:

ziurx@earthlink.net
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http://www.pixologic.com/zbrush4/


3DTotal presents the new issue of 3dcreative
magazine: a downloadable monthly magazine for 
concept art, digital & matte painting for only £2.75 (approx $3.78 - €2.93)

visit www.3dcreativemag.com 
to download the free ‘lite’ issue, the full issue, subscription 
offers and to purchase back issues.

http://www.3dcreativemag.com


Fantasy plays a huge part in digital art. It influences thousands of 

artists from around the world and has become a large part of the film 

and gaming industry. So much of what we see within this genre is 

drawn from fairy tales and folklore. In this tutorial series our artists will 

be showing us how to research creatures from folklore and use this 

gathered information to create an original and accurate depiction of 

these fantasy characters.

- Free Brushes

Chapter 1: September Issue | Goblin | Andrei Pervukhin 
Chapter 2: This Issue | Fairy | Nykolai Aleksander 
Chapter 3: November Issue 59 | Siren | Min Yum 
Chapter 4: December Issue 60 | Ogre | Richard Tilbury 
Chapter 5: January Issue 61 | Troll | Simon Dominic Brewer

http://www.2dartistmag.com/tutorial_resources/issue_058_oct_2010/tutorial03_brushes.zip
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Painting Creatures From 
Folklore: Chapter 02 - Fairy
Software used: Photoshop

The moment we set foot into the world of 

Mythology and Folklore, one of the first 

creatures that has a tendency to pop its head 

out of the often not so metaphorical woodwork 

are the Faeries - or one of their numerous 

relatives, from Elves via Pixies to Faes and back 

again. The artists who have captured them are 

just as numerous, from traditional greats such 

as the Godfather of Faerie Art, the one and only 

Brian Froud, to digital Glamour Faerie queens 

such as Linda Bergkvist. We can go back in 

time, too, and look at some of the old masters 

that fell victim to the spell of Faerie art, such as 

Henry Fuseli and William Blake - even before 

the Victorian era where the craze really took 

hold.

One thing most of these have in common, 

though, is that the Faeries were portrayed as 

human looking (although Froud is known to 

have introduced some truly cruel and gruesome 

looking Elves into our minds). But what is about 

Faeries that seems to fascinate people? Where 

does all this come from? Or more to the point, 

where do Faeries come from? (Fig.01).

All this sounds rather botched up to me, “too 

many cooks” and all that jazz, which from an 

artist’s point of view is just great, because it 

means we can do as we please.

Some of you who know my work will wonder 

why I was asked to shed some light on how to 

paint them, as I myself am a self-proclaimed and 

avid Faerie avoider (if not hater). Someone’s 

idea of a joke, no doubt, or psychological 

warfare - the jury is still out on that. In any 

case, you’ll have to deal with my idea of these 

creatures, whether you like it or not.

So let’s find out what that idea is, and have a 

look at how to paint these elusive things, making 

use of Photoshop and our trusty Wacom tablet.
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Nature’s Law
Unlike Murphy’s Law, this does not mean you 

will probably tread on a Faerie if you stop 

looking for them. It just means we have to start 

seeing the world with different eyes. There 

will be no gorgeous gowns or glitter - no self-

respecting Faerie would be seen dead wearing 

such cumbersome and camouflage-defeating 

things. No. We will take a hint from nature and 

transfer the concept of its perfection onto its 

supposed guardians (or devils, depending which 

side you come down on). This is simpler than 

you may think. Let’s have a look at the list of 

things to consider:

1. Faeries are never seen (no “but”, Period!)

2. We all know that feeling of being watched, 

even though we know we are alone

3. We all know how some inanimate objects 

seem to have a mind of their own.

So now, let’s take a step back from the tacky 

postcard racks in New Age shops around the 

world, and instead use our imagination for a 

moment.

Let’s stick with a humanoid figure for starters. 

Why? Because familiarity is good, no matter 

what. To be able to somewhat identify with a 

fictitious creature is what makes us like them. 

And now let’s take a look at insects, or more 

specifically the Praying Mantis (Fig.02). Yes, 

that’s my fingers in the picture, and that’s a fully 

grown female Green Mantis.

The green Praying Mantis is, however, by far 

the most boring looking one. If you Google the 

Ghost Mantis, the Dead Leaf Mantis, or the 

Orchid Mantis, you get the idea why I am so 

keen on using this insect in our search for the 

“ideal” Faerie: They really are quite something 

special.

Anyway, this particular Faerie would reside 

in or around orchids, nowhere else. I could 

give you tree faeries (separated into bark 

and leaf faeries, of course), water faeries, 

grass faeries, stone faeries or sand faeries, 

but I figured the Orchid Faerie would be 

more interesting to look at, as well as 

marginally dangerous. Certainly not the type 

you’d want to subject your pet gerbil to.

But designing one and ignoring all the 

others would be no good, not for any 

tutorial, or to get a point across.

If the Orchid Faerie is the link to something 

reminiscent of the past and nature, what 

about our modern world? Surely, with the 

technological advance of mankind, Faeries 

adapted too into the kind that crashes our 

hard drives, or stalls our car batteries. You 

get the idea. You’d not want to annoy it, 

because it will, without a doubt, delete 

your address book or leak your number to 

telemarketers. The Mobile Phone Faerie 

has several cousins, and sometimes I 

wonder if they switch residence when 

given the chance (and a USB cable). 

Let’s keep it simple - we want to focus 

on the Faeries, everything else is 

just extras. We need a phone (my 
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BlackBerry seemed good for this), 

and some orchids, and of course 

the Faeries. You can see I added 

a book as well; that’s just me being 

facetious, seeing that I already 

have a certain book in mind to 

feature in the piece (Fig.03). Of 

course, the sketch is on a separate 

layer, to make it easier for us to 

paint underneath it. Filling the 

background with a color rather 

than leaving it white helps set the 

mood and also aids in getting the 

colors right once we start to block 

them in.

We’re going to stick with the 

background for now, as I think 

it’ll be beneficial to the Faeries. If we start with 

painting them, we will be very limited later in 

choice of colors for the background (remember, 

we want them to sort of blend in). So let’s grab 

a nice chunky brush and plop some color on the 

background of the canvas (Fig.04). 

Even though this already looks quite neat, it 

really isn’t. I normally paint props such as the 

phone and book on separate layers, which 

I didn’t do this time round - it’ll make it a bit 

harder for me later to refine certain parts of the 

background, but that’s okay. You may, however, 
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want to paint such items on 

separate layers.

For the orchids, I do add a 

separate layer and lay their 

colors down just as I did with 

the background. There’s many 

different species of orchids, not 

just white and pink, so when 

painting these beautifully deadly 

flowers, have a look around online 

for some inspiration. (Fig.05) Fun 

complimentary colors make the 

image pop.

Before I continue to refine the 

background more to set the 

scene for our dear creatures, I 

want to get some base texture 

into it. Now, we can do this in 

several ways, like with texture 

brushes, or - as I choose to do 

here - with a texture image. 

You can find royalty free photo 

textures in 3DTotal.com’s 

texture library, or just go and 

take your own. I had taken 

some pictures of a patch of 

grass a while ago, so I’ll be 

using one of them to work into 

the background (Fig.06). 

Drag the photo over to your 

painting and resize it so it 

covers all the bits you want 

covered. Then erase the parts 

that overlap the props (which 

wouldn’t be the case if you 

had your props on separate 

layers). To make it blend a bit 

better with the painting, we 

can apply a filter such as the 

Median Filter (Fig.07). 

And to make the grass 

texture blend in we simply 
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set the layer to Soft Light, and reduce its 

Opacity a little if needed (Fig.08). There, 

looks much better already!

We now turn our attention back to the 

Orchids. Using a softer round brush than 

before, loosely refine the petals and stems. 

To blend the colors somewhat, we use the 

Smudge tool with a textured brush tip, with 

Angle Jitter set to 50%, Scatter to around 

5% and Opacity to Pen Pressure. These 

settings stop it from looking smeary, and 

give you an even blending of colors.

We also add another texture photo here 

beneath them (Fig.09) and do what we 

did before with the grass to make it work 

(Fig.10). 

Giving nature a break, let’s have a look 

at the phone. First work it over with 

a standard round hard edged brush - 

seriously, no fuzzy here! It’s a plastic 

and metal object, and they just don’t 

have fuzzy edges. Once the keys look 

as we want them to, we can start to 

think about adding the key faces. Using 

the Type tool, choose a font that is 

similar to the one on the actual phone, 

and type out everything we see. The 

next part is horrendously tedious, but 

worth it: Rasterize the type (Layer > 

Rasterize > Type) so we can actually work with 

it as we need to. After that, cut out the individual 

letters and symbols and place them onto the 

keys, not forgetting to adjust their perspective 

(Edit > Transform)… fun!

When you can finally can say it’s done, we 

can look at making the symbols that were not 

available in type, such as the arrows. Luck has 

it that these are available as default shapes, so 

we can take the Custom Shape tool, then select 

the arrows we need from the little menu at the 

top. Once again, to properly work with these 
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Shapes once we have them all we need to 

rasterize them (Layer > Rasterize > Shape). 

The BlackBerry Logo and the green and 

red receiver buttons get painted (Fig.11). 

And we’re almost there with the keys! To 

really make the lettering work within the 

painting, we need to blur them slightly. So 

go to Filter > Blur > Gaussian Blur and 

adjust the settings to your liking, then hit 

OK (Fig.12). 

Now let’s get the book fixed up. I 

personally find it easiest to just use the 

default round Paint brush with Size Jitter 

and Opacity set to Pen Pressure to paint 

the illusion of pages and pull the edges 

of the cover into focus. It’s a straight 

forward thing, really. To blend certain 

sections, we use the Smudge tool again 

(Fig.13). 

With this out of the way, we can look at 

the rest of the picture again, and give it 

equal attention - because it needs it. 

I’m not happy with the high saturation 

of the Orchids, so I desaturate them 

a little bit. Easiest way to do that is to 

go into Image > Adjust > Desaturate, 

then Edit > Fade Desaturate. Also, 

I am not keen on the positioning of 

them, so I move them about a bit 

until I think it looks fine. I also move 

one of the flowers further out and 

extend the stem to give the Faerie 

that will sit on it more space. I also 

add the shadows that the Orchids 

would throw on the stones beneath 

them, and heavily refine the stones 

themselves, first with a hard round 

brush for sharp edges, and then 

with a couple of custom brushes to 

bring out the texture. 

And then I add the text on the 

book using the Type tool again, 
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proceeding as before, rasterizing and adjusting 

its position and perspective, as well as blurring 

it slightly. 

You may also notice I’ve changed the Orchid 

Faerie sketch slightly - the first one was just… 

you know, cartoony and bad (Fig.14). 

Now that the background is at a nice level 

of quality, we can move on to the Orchid 

Faerie. As we want the creature to be nicely 

camouflaged, we’re going to use a similar color 

palette for it as we used for the immediate 

surroundings: the orchids, grass and stone. 

Rather than picking colors from the painting with 

the Eyedropper tool, let’s take a screenshot 

of the image and crop it to that portion of the 

picture instead (Fig.15). 

Now we go into the Filter menu, go to Blur 

and choose the Radial Blur. Essentially, we’re 

going to mix ourselves a palette - the fast way 

(Fig.16). The result is something very usable 

(Fig.17). 
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famous “yucky” stage (where things just look 

not as great as you would like them to), it’s also 

the stage where you can play around a lot until 

you get something worth taking further. Many 

artists do this with thumbnail sketches, or line 

sketches, which is not a bad idea to be honest. I 

should think about taking that up…

Next up, let’s refine the face a little (Fig.20) to 

get a better idea of what we’re looking at. 

The reason I’m taking this 

route is because picking 

the colors directly from the 

painting won’t give us enough 

color variation - as in, the 

Faerie would have the very 

same colors as the flowers 

she happens to sit on, which 

is not too beneficial - for the 

Faerie, or us. Camouflage 

= good. No chance of 

blending in with slightly 

differently shaded orchids 

from the same family = bad. 

You get the idea.

So let’s get started by 

blocking in the main colors 

we want to use. We add a 

new Layer for the Faerie of 

course and, using the plain 

round brush with Opacity set to Pen Pressure, 

get to work (Fig.18). 

At this point I realize I’m not really happy with 

the pose, especially the arms, so I fix that and 

then continue refining the Faerie’s overall color 

before even contemplating going into any kind of 

detail (Fig.19). If you’re not that confident about 

just changing a pose at a moment’s notice, you 

may want to work things like this out in a new 

sketch before continuing. I have the (bad?) habit 

of changing my mind halfway through a painting 

about certain aspects of it, and no doubt this 

won’t be the only time in this tutorial you’ll see 

me go “Uh, nah…”.

So now that I’m kind of happy with what I’ve 

got, I set about refining the light and shadow, 

and add the first details. Aside from being the 
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I spoke too soon about being happy with what I’ve got, as here’s another 

pose change. It’s the last one, promise! Of course, we continue to refine 

the overall appearance of the Faerie (Fig.21). You may notice a vague 

texture on its skin, which was done with a chunky rough speckled brush, 

with Angle Jitter set to 50%, and Opacity and Flow set to Pen Pressure. 

This texture won’t be very visible by the time we’re finished with it all, but it 

may still shine through here and there and add an extra amount of… well, 

texture and depth.

Here’s a little tip for adding the shadows of the Faerie (or in fact anything 

else you’re painting): rather than using black, which really dulls everything 

down and makes things look very pasty, use a darker shade variation of 

the color from the surface the shadow will be on. In this case, I used a 

burnt orange on the yellow petal of the orchid at the top for the shadow 

under the arms, a slightly lighter orange for the one the leg crosses over, 

and a deep purple red for the shadow that grounds the left foot claw.

Once we are satisfied with how the Faerie looks - the pose, expression, 

some hint of details, etc. - we can look at adding more colors.

The reason why I personally prefer to start off with a more muted palette 

is it’s easier to build up to vivid and varied colors than toning them down 

again, especially when working with red, orange and purple pinks - these 

can get oversaturated very quickly. And right now, I am not sure yet just 

how “in your face” I want this to be. 

First of all, let’s adjust the contrast slightly. I prefer doing this by using 

Levels, rather than Contrast (Image > Adjust > Levels), but whatever you 

use is really up to you (Fig.22). 

Now, to get some inspiration for patterns, we can again look at various 

insects, such as caterpillars or beetles, as well as amphibians (especially 

some of the tropical frogs which are stunning). But really, anything goes - 

it’s a Faerie! 

A good way of adding patterns and texture is with a custom brush, be 

it by stamping the texture/pattern on, or using the brush like a normal 

paintbrush - it all depends on what you want to see in the end. Always do 

this on a separate Layer, so you can adjust it or delete it if you don’t like it 

(Fig.23). 
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I add a more contrasting pattern in bright 

orange/red on the lower legs with a different 

custom brush, and accentuate it with yellow 

around the edges to make it stand out a bit 

more (Fig.24). This whole process is a “trial and 

error” thing - sometimes it works out straight 

away, sometimes it doesn’t, so just play around 

and see what you think looks good, and what 

you like.

I’m pretty happy with the Faerie now, but 

there’s still something missing: Wings. 

No Faerie is complete without them (or 

so we’ve been made to believe). Actually, 

I’m adding them in because the wings 

are what draws many people to these 

creatures in paintings, and also what many 

people seem to really have a problem with 

painting. I have stumbled across decent 

enough Faerie paintings where the wings were 

just so cumbersome and weighty, that I could 

have used them to successfully swat the Faeries, 

a lot of times.

So let’s take a look at what goes, and what 

doesn’t, in relation to the Faerie in this painting. 

It’s obviously a small creature, and one would 

imagine quite fast, too. The fact that it’s based 

primarily on insects rules out feathered wings 

(really, those are reserved for birds and Angels). 

We can also rule out the stereotypical butterfly 

wings, as these too are too heavy and dense 

looking. Besides, the word “tacky” springs to 

mind again. What we want here is something 

light and transparent. Think Dragonfly, or well, 

Mantis. If you check the latter up online again, 

you will find some stunning examples of their 

wings, and what they use them for, namely not 

just flying, exactly what we want here really.

Sketching the wings on a new Layer works 

best, with a small round brush with Size 

and Opacity set to Pen Pressure (Fig.25). 

Remember not forget the wing(s) that will be 

somewhat obscured behind the Faerie, or else 

it will fly in perpetual circles. 

The first thing I do after that is attack the 

sketch lines with the Smudge Tool (same 

settings as previously described) (Fig.26). 
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Using the round Paint brush with no Size Jitter, and Opacity and Flow set to Pen 

Pressure, as well as manually reduced to something around about 40%, I fill the 

wings in and erase the bits sticking out over the lines with a soft edged eraser. 

Use a new Layer which you can merge with the line sketch Layer once done - 

that way you can change the Opacity if you wish (Fig.27).

Now that we have a basic transparent set of colored wings, we can work out the 

details. When doing this kind of work, I personally like to use separate Layers 

for the details I add to have more control over adjustments, which can come in 

very handy when painting transparent things that you wish to keep looking as 

transparent as possible. Duplicating Layers and playing with Layer Modes can 

have some great results (Fig.28)! 

You may have noticed that I removed the obscured set of wings while working 

on the ones in full view. That’s because there is no need to paint the other set, 

as we can just duplicate the one we’ve got once we finish it, and then adjust the 

perspective to work with the slightly different angle (Fig.29). If you have lots of 

Layers for your wings that cannot be merged (some Layer Modes do not like 

merging unless you have a solid colored layer to merge them with), put all the 

wing Layers into a Layer Set and duplicate that, rather than all the separate 

Layers.

With the wings done, we move on to the second Faerie. First of all, I want to 

change this one, as it’s way too “Romeo and Juliette” for me. Turning the whole 

“corrupting files” over in my head, I figured why not use that here. Can you guess 

what the Phone Faerie just did (Fig.30)?

Before going any further with the arm, let’s see about making the screen come to 

life with a fuzzy brush in an almost white color. I employ the Noise Filter to make 

it a bit more convincing, then duplicate the Layer and set it to Overlay (Fig.31). 

Happy with that, I go back to the arm and refine it, using various shades of 

electric blue and turquoise (Fig.32).

http://www.2dartistmag.com


page 80www.2dartistmag.com Issue 058 October 2010

Chapter 2: Fairy Painting Creatures From Folklore
Now we just need to make it work where it 

pops out of the screen. Also, it would be nice 

to make that Faerie a little bit more… sci-fi. 

Let’s take down the opacity of it to make it 

more transparent, like a hologram (Fig.33), 

then duplicate the layer and set it to Overlay 

(Fig.34), and to make it a little brighter, we 

can adjust the Levels of the original arm 

Layer until we have something we like 

(Fig.35). 

Of course, we will have to add some 

reflective glow on the phone and 

surroundings, but we will do that in a little 

while. First I would like to continue with 

what the little guy actually did in the phone. 

Well, let some photos disappear, of course. 

Most likely our Orchid Faerie accidentally 

got caught on camera as the reader of the 

book took some pictures of the Orchids, 

and now all evidence has to be deleted. 

To add the delete confirmation info on the 

screen (Fig.36), I just used the Shape tool and 

selected the Rounded Rectangle, rasterized 

the shape (Layer > Rasterize > Shape), then 

added the white border by using the Layer 

Styles (Layer > Layer Styles > Stroke…) and the 

shadow, also with Layer Styles. I did the same 

for the blue “OK” button then added the text. 

After merging the layers, I adjusted the position 

of the info box to match the perspective of the 

screen, and gently erased parts of it to blend 

in better. Some slight blurring and then adding 

Noise helps!

Righty…

Now that we have all the major elements done, 

let’s concentrate on the loose ends that need 

tying up. First, I reduce the 

Opacity of the book’s title, as 

it seems a bit too much. I also 

notice that there is a distinct 

“gap” right in the middle of the 

picture, an invisible line drawn 

between Orchid and Phone. To 

close that gap a little and make 

the image work better, I grab 

the Orchids with the Faerie 
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and nudge them further to the left (Fig.37). Linking all the affected 

Layers before doing that is advisable here, as it saves you having to 

shift them individually. Then I crop the canvas, using the Cropping 

tool, and also resize the Orchids and Faerie a little, making them 

bigger (Fig.38). 

Next up, add some more details to the background. Where the 

Phone Faerie’s arm is, I blur the bits behind it, as whatever is behind 

it would probably not be as clear but rather like looking through a 

frosted or smudgy glass.

I also want to add a little more detail to the grass. Using a custom 

brush that looks and acts a bit like a palette knife, with Size and 

Opacity set to Pen Pressure, I randomly paint grass stalks here and 

there, and using the Median Filter and also the Blur tool make them 

blend in with the already existing texture. I also add another photo 

texture behind the Orchids, and layer it with a brush texture (Fig.39). 

Great! I think that’s pretty much it on the active painting side of things, 

and it’s time to look at the very last overall adjustments.

I’ve started the habit of making a copy of my work (Image > Duplicate), 

so if I don’t like what I do in the end, I can re-open the original file and 

start over.

The first thing I tend to do is individual Levels adjustment to either even 

out the contrast, or to pop out certain parts of the image. After that, I 

flatten the image (Layer > Flatten) to once more adjust the Levels, and 

also to play with the Variations (Image > Adjustments > Variations). 

These are all very subtle adjustments, but often have a great impact 

(Fig.40). 

Now it’s time for the reflective blue glow I mentioned earlier around 

the Phone Faerie’s arm. For this, I add a new Layer and set it to 

Linear Glow, then take a fuzzy round brush, pick a bright blue, 

and carefully paint the light. Duplicating the Layer and setting it to 

Overlay, and then adjusting the Opacity of both Layers will give you 

some nice results. - I don’t want the glow too strong, just a hint. If 

you want it stronger, remember to add some actual highlights to the 

items closest to the glow. I put a little on the Orchid Faerie’s face 

and hands (rather, claws) for subtle effect, as that lifts its face off the 

book in the background (Fig.41). 

I add another Layer set to Overlay and, picking a warm yellow/

orange color, I carefully light the Orchid Faerie and everything that 
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is not within reach of the blue glow. The result 

should be visible, but not over the top, just 

enough to really pop the Orchids and Faerie as 

the main attraction in the painting (Fig.42). 

We flatten the image again, and adjust the 

Levels one last time if needs be.

We’re pretty much done now, but to really finish 

off the painting, we may want to consider adding 

some focal blurring. It’s easiest at this stage to 

do this by hand with the Blur tool. But carefully, 

as it’s quickly overdone, and we want to avoid 

that. We want everything still clearly visible. 

Just soften the edges of some of the things that 

would be slightly out of focus.

And there we have it! 

Happily Ever After
So, it is possible to paint these creatures without 

glitter or the token butterfly wings… and even 

if you’re a fan of the classical Fae, there were 

hopefully still some things that you found useful. 

Now go and get your pins and glass jars ready, 

and catch yourselves some Faeries. Happy 

Hunting!

Nykolai Aleksander
For more from this artist visit:

http://www.admemento.com/

Or contact them at:

x@admemento.com
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Custom brushes are not only a great way to increase the speed at which a painting can be completed, but can also create an effect that would 

otherwise be impossible. They can be used in many different types of scene, but many would argue that they become most useful when 

creating a space scene. In space many items need replicating or reproducing in vast quantities, which can be difficult, but custom brushes can 

make this process much easier and simpler. In this series the artists involved will be showing you how to create brushes to improve your scene 

and how to use them to the best effect.
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Custom Brushes For Sci-Fi 
Chapter 4 - Underground 
Corridor 
Software used: Photoshop

Introduction
I have focused this tutorial on some of the 

elements you can find in underground corridors, 

such as wires, tubes, volumetric light from vents, 

and other typical sci-fi architectural elements. 

These small elements may seem superfluous 

but an image looks better when its smaller parts 

work perfectly. My intention is not to show the 

reader how to draw underground corridors, 

but how to design brushes to help him in the 

process. I always recommend gathering photos 

and illustrations of sci-fi environments to have 

a good collection of images that will help you to 

create brushes.

Custom Brushes to Draw 
Tubes
First of all, you have to know what kind of 

tube or wire you want to paint in the scene. I 

have selected a corrugated tube photograph. 

The geometry is easy, but drawing it without a 

custom brush will be boring and hard. It has a 

repetitive pattern along its length and we can 

design two brushes to draw it depending of the 

perspective of each segment (Fig.01). 

These patterns must have rotation controlled 

by the stroke direction. Photoshop allows 

us to position the brush image depending 

on the movement and direction of the pen. 

You only have to change the Angle Jitter 

control parameter to Direction and control 

the roundness jitter with the Pen Pressure to 

simulate perspective (Fig.02). Unfortunately we 

can’t convert our brush parameters to create 

a straight line (if we set the Roundness to 0%, 

the shape disappears). Because of this I have 

designed two brushes (to cover all perspective 

possibilities) (Fig.03). You’ll find these among 

the free brushes provided with this tutorial.

We are going to view this brushes in action. 

First, I create a layer and draw the tube in solid 

color with a normal round brush (I have used 

a light tone to do it). If the size of the brush is 
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affected by pressure, you can vary the size 

of the tube to simulate perspective (Fig.04). I 

lock the layer to shade the tube with a normal 

aerograph-shaped brush (Fig.05). Then, in 

another layer, I select the brushes I designed 

before to draw the corrugated surface of the 

tube in a darker tone (Fig.06). I have used 

the two brushes I designed before (marked 

numbers 1 and 2) to show the importance of the 

perspective.

Try different types of tubes, changing the brush 

spacing or creating new shapes for the tube 

segments. Take a look at the tube on the top of 

Fig.07. I have drawn it with two brushes (“Tube 

2”) that you can find in the set of brushes that 

comes with this tutorial. 

A Lot of Wires
Wires are common elements in underground 

sci-fi environments. The main problem when 

drawing wires is not the wire itself, but creating 

a quantity of them. We have two options when 

facing this task: Draw each wire with a single 

round brush, or create a brush that paints a set 

of wires. The second option allows us to draw 

a set of cables at once with the advantage of 

maintaining the same space between them. I 

created a new brush pattern with three circles 

(Fig.08). We need to control the size with the 

pen pressure. If necessary, try the brush to paint 

different angles that show perspective (Fig.09). 

I have rotated the pattern slightly to draw the 

wires in a new layer and create a credible 

perspective (Fig.10). Finally, I have locked the 

layer to shade the wires (Fig.11).
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This brush may be as complex as you need 

it to be. Try adding more wires of different 

thicknesses. There are thousands of 

configurations. 

Drawing Volume Light from 
Vents
Volumetric light in an illustration can be a 

doubled-edged sword for an artist. The effect 

can be great and stunning. On the other hand, 

creating credible lighting is difficult and many 

artists add exaggerated effects that ruin the 

final image. The volumetric light must be 

considered as part of the image composition. 

I would recommend that you do not force its 

inclusion. In my corridor image, I decided on 

the area of volumetric light right from the start. 

An area of lighter tones is perfect to define an 

image (Fig.12), but what can I do to make this 

light look better? I need the light to appear as if 

it is passing through vents or grills. To show this 

effect I have designed an easy brush.

The first step is creating a brush pattern similar 

to a single ray of light (Fig.13). To create a 

new custom brush you have to set Opacity and 

Flow Jitter to 100% to simulate different light 

intensities passing through the ceiling vents 

(Fig.14).

Applying this to the image is easy. First make a 

straight horizontal stroke in a new layer (Fig.15). 

Then, select the rectangular Marquee tool to 

distort the geometry of the layer and adapt it 

to the area and direction of the light (Fig.16). 
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Finally, we adjust the opacity of the layer and 

make a few adjustments to create a good result 

(Fig.17).

Don’t forget to add a dusty atmosphere in this 

kind of underground scene. Volumetric light 

appears when the air has particles and dust in 

it. Try the “Dust” brush I designed. It’s based on 

a single dot with Scattering effect and Opacity, 

Angle and Roundness Jitter (Fig.18). The result 

is a helpful brush full of particles with different 

shapes, angle and intensity.

Thousands of Brushes
Let’s move on to something a little easier. 

Most sci-fi scenes have a lot of geometric 

and repetitive patterns that are repeated in 

architecture. Grids, buttons or bolts for example, 

are elements that can be simplified with good 

brush designs. Dirt and metal reflections are 

also essentials for surface treatment (Fig.19). 

Take a look at the longitudinal vent on the top 

left corner of the corridor. A simple brush of 

parallel bars is enough to give complexity and 

realism to the environment. You only need to 

use it at an adequate angle and set the brush 

size sensitivity to pen pressure. As you can see 

with most of the brushes in this tutorial I have 

controlled the size with pressure. It’s common 

in images with strong perspectives, because 

you need to work with elements that vary in size 

to show depth and perspective. Gathering a 

collection of this kind of brush makes our work 

faster, easy and more effective.

Creating custom brushes is a meticulous task 

that creates a new range of possibilities in your 

drawing technique. All the custom brushes I 

created for this tutorial are used in the image, 

and you can download them for free. Explore 

them and design new ones to create different 

elements in your underground environment 

scenes. Before you draw any element, think 

for a while about how you can make it with a 

custom brush. Having your own set of brushes 

is essential if you want to achieve a more 

complex and personal drawing technique. 

The time spent creating custom brushes it is 

regained in the creation of your paintings.

Roberto F Castro
For more from this artist visit:

http://www.robertofc.com/index.html

Or contact them at:

contact@robertofc.com

– Free Brushes
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“Share One Planet” Wild Animals CG Art Elites Invitational Competition is organized by Wild Animals Cultural Project Fund, China Foundation 
for the Development of Social Culture, China Institute of Strategy and Management (CISM), the International Association of Computer Graphics 

Artists (IACGA), China Association for Global Development under the United Nations and co-organized by leewiART International Computer 
Graphic (CG) Art Promoting Organization and Beijing Imperial Court Development Company Ltd.. It is an art gathering on CG art platform and in 
the theme of wild animals’ protection. “Share One Planet” is the first one who combines CG art and wild animals’ protection together, invites top 

global CG artists for raising attentions towards the survival of wild animals. “Share One Planet” is the first global competition of “Share One Planet” 
series. The Organizers hope the platform of “Share One Planet” can be built for encouraging artists to create meaningful and inspiring CG works to 
our times, for promoting great CG artists and for raising attention to wild animals even global environment protection by employing the power of art. 
Winners will be awarded with prize money as well as special designed golden, silver and copper trophies. Winning entries of the competition will be 
first exhibited in China and then toured internationally. As one of the top CG art competitions, it won many global top CG Medias’ full supports, they 
are: CGSociety, ImagineFX, 3DCreative and 2DArtist, 3DTotal, Chinavisual, CGW and 32D. Their participation echoes with the theme of this grand 

meeting and surely will be a “Share One Planet” visual of CG world.

Competition Schedules
Submission: August 1st, 2010 – February 28th, 2011 (BJT, GMT+8)

Judging: March 1st, 2011 – April 1st, 2011 (BJT, GMT+8)

Awards Announcement: April 15th, 2011 (BJT, GMT+8)

For more information, please visit our website: http://www.shareoneplanet.org
Send your works to: shareoneplanet@gmail.com, and selected artist will be granted with an invitation code.
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If anyone knows about digital painting techniques it is Yang Xeuguo as he is an art teacher at a 

university in China. In this Making Of, Yang doesn’t only share his thought process behind this 

amazing surreal art, but also gives great advice on some of the fundamental art subjects.

“Pay attention to the 
changes of highlight on 
the subject, whether it is a 
rough or glossy surface”
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This image was for a CG exhibition, named 

“Industrial Impression: Design & Creation 

Exhibition”. I used a lot of industrial elements 

as fodder for the creation of this image. The 

purpose was to show the relationship between 

the development of post-modern industry and 

the human way of life. There wasn’t any clear 

intention at the start of my creation process, I 

just blocked in some shapes at random. Then 

I gathered the interesting parts of them and 

ultimately created a final concert composition 

(Fig.01). 

To make sure the sketch layer was complete 

before adding color, I looked at pictures of some 

industrial materials and then blended them into 

the image. The aim was to keep the style and 

design bold and interesting, but to also try and 

maintain the feel of the scene. I then added 

more details as I adjusted the composition. 

As you can see from the sketch, everything in 

the distance looks lighter and the colors are 

stronger in the foreground. This gave a good 

sense of depth (Fig.02). 

I then selected a large brush to add color to the 

image in a single layer. I set the brush mode to 

Multiply and then selected warm colors to paint 

on it. Multiply mode allows color to be added to 

the sketch transparently, and will not cover the 
original sketch layer. It is a commonly used color 

method, but do not select dark colors or paint 

over it repeatedly. If you paint in Multiply mode 

with darker colors repeatedly in one place, it 

will make the image black. Making the image a 

little darker can enhance the tone of image and 

also offer a nice base tone for adding all kinds of 

highlights later (Fig.03).

With a basic color set I then began to paint 

in the details. I started with the tones in the 

distance. I tried to keep the tone and colors 

consistent with those in the previous sketch and 

the strength of the color in the distance low. To 

do this I decreased the color’s saturation. I also 

kept the whole image in warm tones, making 

sure there wasn’t too much contrast, and made 

sure that the only light in the scene was diffused 

(Fig.04). 
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What is “diffuse”? Diffuse is when the 

environment has no direct light, like on a rainy 

day, where there is only light reflected from 

other objects. This usually means there is no 

obvious direction for this kind of light, so the 

shadows are not clear. The shadows created 

by diffuse reflections appear in the close areas 

between the objects. We can see how the 

diffuse reflection works in the following picture. 

If you understand this relationship then you will 

know where to place the shadow (Fig.05). 

To demonstrate that a surface is hard I 

usually use a Hard-edged brush with 100% 

transparency and no feathering edge so we can 

portray the solidity of the item. I pay attention to 

the texture features (like rusted metal, concrete 

etc) and change the brush’s size and direction 

depending on what you are painting (Fig.06).

The Smudge tool helps when blending the 

colors, especially when drawing the background. 

Here I used the Smudge tool to deal with the 

edge of adjacent colors. It created soft tones 

and shadows (Fig.07). 

There are various ways to define details; you 

can use the brush to add texture or overlay a 

photo. I prefer to use a block-shaped brush and 

paint it in freely, making sure that I portray the 

highlights when painting. The highlights are 

very important and the different highlights will 

determine the final texture of the substance. 

For instance, in this image the highlight and 

the strength of color are extremely different, 

particularly between the smooth and the rusty 

metal. Normally a high intensity small area 

highlight will make the subject look smooth and 

hard, whilst a soft and coarse highlight will do 

the contrary. It’s important to pay attention to the 

changes of highlight on the subject, whether it is 

a rough or glossy surface (Fig.08). 

With regard to light and shade; diffuse reflection 

is one of the elements that will set tone of the 

image, but there is also direct light and bounce 

light. In more complex images the portrayal of 

light on surfaces is very important, especially the 

bounce light, and if there is not enough bounce 

light the whole image will become dull and 

perspective will be lost. In Fig.09 you can see 

the different types of light I used in this image.  

The next step was to paint in all of the details, 

adding highlights as the last steps (Fig.10).

Effects were essential for this image, such as 

light, smoke, fire, lightning, etc. I used custom 

brushes to paint these effects. To paint on 
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the same layer I set the brush mode to Color 

Dodge. To paint on a new layer, I set the whole 

new layer to Color Dodge mode. Then I was 

able to achieve a “transparent light” effect 

(Fig.11).

Here are some tips for how to make a smoke 

effect brush: 

1. Create a new 500x500 pixel, 72DPI, pure 

white background layer. 

2. Draw some black dots (Fig.12). 

3. Paint a gray girth at the edge of the dots 

and then you can create a transparent mist 

effects.

4. Add “Ocean Wave” filters to it to move it 

closer towards a cloud effects. 

5. Add “Box Blur” filters to it and soften the 

edge (Fig.13).

6. Go to Edit > Define Brush Preset and 

set parameters as shown in Fig.14.

Done! I used this brush in many parts of the 

image. And this technique can be used to create 

other brushes. If you want these brushes to 

make a glitter effect, make sure the brush mode 

is set to Color Dodge (Fig.15). 

Finally I used a uniform texture layer to enrich 

the texture and details. I used textures such as 

paper, cloth or concrete, then placed them on 

the top layer and modified the layer mode to 

Overlay. Then there was a delicate texture on 

the image (Fig.16).

Yang Xueguo
For more information please visit:

http://seedsfromhell.blogspot.com 

Or contact them at:

blur1977@126.com
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With the release of 3DTotal’s book, Digital 

Art Masters: Volume 5, we have some ex-

clusive chapters for you...

This is more than just an artwork book. 

Not only does it feature full-colour, full-

page images, but each artist has given a 

detailed description, in their own words, 

of the creation process behind each piece 

of published artwork. And they’ve done it 

especially for this book! 

This month we feature:

“Cowboy Vs. 
Sandworms” 

by Kekai Kotaki



The following shots of the “The Gateway” book pages are featured here in full-resolution and can be read by zooming in...





View the entire 
Digital Art Masters: Volume 5 book online at

www.3dtotal.com/digitalartmasters_v5

Digital Art Masters is in its  
fifth edition now, and can easily 
be considered one of the best 
showcases of digital artwork 

available today. The quality of the 
artworks, the fine printing and the 
valuable walkthroughs make this 

book a must-have for any art lover 
and for any CG artist, professional 

or beginner.
Alessandro Baldasseroni | www.eklettica.com

Following on from the success of our first four books, we received yet another 
overwhelming response to our call for submissions for Digital Art Masters: Volume 5. Once 
again over 1,100 submissions made their way into the Digital Art Masters mailbox, proving 
to us that the series is becoming ever more popular with not only our readers, but artists 
around the world too!

From this massive number of incredible entries, the 3DTotal team began the difficult task of 
choosing approximately 300 images to take through to the next round. To help in the task, 
we enlisted the help of industry professionals Tim Warnock (matte painter), Till Nowak (3D 
artist) and John Kearney and Chung Wong (videogame artists - VooFoo Studios) to be our 
guest judges. These wonderful artists braved the headaches of a grueling judging process 
and helped the 3DTotal team to select the 50 stunning images that appear in this year’s 
fantastic line-up.

Hardback - 21.6cm x 27.9cm | 304 Full Colour Premium Paper Pages | ISBN: 978-0-240-52171-8

Visit 3DTotal.com to see our full range Book products
3DTOTAL.COM

http://www.3dtotal.com/digitalartmasters_v5/


Available from www.3dtotal.com/shop

Meet some of the finest digital 2D and 3D artists working 
in the industry today – Loïc e338 Zimmermann, Craig 
Sellars, Jelmer Boskma, Maciej Kuciara, Daarken, 
Marek Denko, Kekai Kotaki, Andrew Hickinbottom 
and Marek Okoń. Become inspired by breathtaking 
images, paired with the techniques and tricks of leading 
industry artists

• More than just a gallery book, learn from the best 
digital artists in the world; each artist offers insight 
into how their image was created, with discussions of 
techniques and problem solving solutions

• A source of inspiration for artists of all levels: cutting 
edge imagery showcases the best in today’s digital art

• Featuring more than 50 artists and showcasing over 
900 stunning color images in five sections: Sci-Fi, 
Scene, Fantasy, Character and Cartoon

“Digital Art Masters is getting better and 
better at showcasing some of today’s 
best digital artists. The way the book 
shows the processes of achieving great 
pictures provides a good opportunity to 
learn from these artists, and keeps you 
challenged in your own art.” 

Raphael Lacoste | www.raphael-lacoste.com/

volume 1 volume 2 volume 3
The first book in the 
Digital Art Masters 
series features 48 of 
the finest 2D and 3D 

artists, including Eric 

Wilkerson, Fred Bastide, 

Marcel Baumann, Meny 

Hilsenrad, Natascha 

Roeoesli, Robert Chang 

& Thierry Canon

The second book in the 
Digital Art Masters 
series features 58 of 
the finest 2D and 3D 

artists, including Benita 

Winckler, Glen Angus, 

James Busby, Jonathan 

Simard, Jonny Duddle, 

Philip Straub  & Tae 

Young Choi

The third book in the 
Digital Art Masters 
series features 60 of 
the finest 2D and 3D 

artists, including Damien 

Canderlé, James Paick, 

John Wu, Laurent 

Pierlot, Marc Brunet, 

Mathieu Aerni, Matt 

Dixon & Neil Blevins

http://www.3dtotal.com/books/
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About us  3DTotal

Is a resource website for the CG community; 

amongst our growing number of products for CG 

artists, we produce two monthly downloadable 

PDF magazines – 2DArtist and 3DCreative. 

We are based in the West Midlands, in the UK, 

and our intention with our magazines is to make 

each issue as full of great articles, images, 

interviews and tutorials as possible. If you 

would like more information on 3DTotal or our 

magazines, or if you have a question for one our 

team, please use the links below.

Contact Information
http://www.3dtotal.com

http://www.3dcreativemag.com

http://www.2dartistmag.com

Editor & Content Manager > Simon Morse 

simon@3dtotal.com 

Lead Designer > Chris Perrins 

chrisp@3dtotal.com 

Marketing > Jo Hargreaves 

jo@3dtotal.com

Partners
If you have a CG community website and would 

like to support 3DCreative and/or 2DArtist 

magazine by showing our banners, please 

contact Simon at the email address above

http://www.2dartistmag.com
http://www.3dtotal.com
http://www.3dcreativemag.com
http://www.2dartistmag.com
mailto:simon@3dtotal.com
mailto:chrisp@3dtotal.com
mailto:jo@3dtotal.com
http://www.epilogue.net/
http://www.cgdirectory.com/
http://www.masteringmentalray.com/
http://news.hiperia3d.com/
http://www.vanishingpoint.biz/
http://www.fallingpixel.com/
http://www.krazybov.com/
http://www.cgpad.org/
http://www.fridgemonsters.com/
http://www.ambiguousarts.com/
http://arttalk.ru/
http://www.inspiring3d.com/
http://www.childplaystudio.com/
http://vainsoftgames.com
http://www.3dhype.com/
http://www.3dm3.com/
http://www.3drevolution.org/
http://www.veegraph.com/
http://www.cgart.ir/
http://www.cgtantra.com
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